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At Quectel, our aim is to provide timely and comprehensive services to our customers. If you 

require any assistance, please contact our headquarters: 

 

Quectel Wireless Solutions Co., Ltd.  

Building 5, Shanghai Business Park Phase III (Area B), No.1016 Tianlin Road, Minhang District, Shanghai 

200233, China  

Tel: +86 21 5108 6236  

Email: info@quectel.com 

 

Or our local offices. For more information, please visit:  

http://www.quectel.com/support/sales.htm. 

 

For technical support, or to report documentation errors, please visit:  

http://www.quectel.com/support/technical.htm. 

Or email us at: support@quectel.com. 

 

Legal Notices 
We offer information as a service to you. The provided information is based on your requirements and we 

make every effort to ensure its quality. You agree that you are responsible for using independent analysis 

and evaluation in designing intended products, and we provide reference designs for illustrative purposes 

only. Before using any hardware, software or service guided by this document, please read this notice 

carefully. Even though we employ commercially reasonable efforts to provide the best possible 

experience, you hereby acknowledge and agree that this document and related services hereunder are 

provided to you on an “as available” basis. We may revise or restate this document from time to time at 

our sole discretion without any prior notice to you. 

 

Use and Disclosure Restrictions 

License Agreements 

Documents and information provided by us shall be kept confidential, unless specific permission is 

granted. They shall not be accessed or used for any purpose except as expressly provided herein. 

 

Copyright 

Our and third-party products hereunder may contain copyrighted material. Such copyrighted material 

shall not be copied, reproduced, distributed, merged, published, translated, or modified without prior 

written consent. We and the third party have exclusive rights over copyrighted material. No license shall 

be granted or conveyed under any patents, copyrights, trademarks, or service mark rights. To avoid 

ambiguities, purchasing in any form cannot be deemed as granting a license other than the normal 

non-exclusive, royalty-free license to use the material. We reserve the right to take legal action for 

noncompliance with abovementioned requirements, unauthorized use, or other illegal or malicious use of 

the material. 

mailto:info@quectel.com
http://www.quectel.com/support/sales.htm
http://www.quectel.com/support/technical.htm
mailto:support@quectel.com


 
                                                    GNSS Module Series 

 

QGNSS_User_Guide                                                                  2 / 57 
 
 
 

Trademarks 

Except as otherwise set forth herein, nothing in this document shall be construed as conferring any rights 

to use any trademark, trade name or name, abbreviation, or counterfeit product thereof owned by Quectel 

or any third party in advertising, publicity, or other aspects. 

 

Third-Party Rights 

This document may refer to hardware, software and/or documentation owned by one or more third parties 

(“third-party materials”). Use of such third-party materials shall be governed by all restrictions and 

obligations applicable thereto. 

 

We make no warranty or representation, either express or implied, regarding the third-party materials, 

including but not limited to any implied or statutory, warranties of merchantability or fitness for a particular 

purpose, quiet enjoyment, system integration, information accuracy, and non-infringement of any 

third-party intellectual property rights with regard to the licensed technology or use thereof. Nothing herein 

constitutes a representation or warranty by us to either develop, enhance, modify, distribute, market, sell, 

offer for sale, or otherwise maintain production of any our products or any other hardware, software, 

device, tool, information, or product. We moreover disclaim any and all warranties arising from the course 

of dealing or usage of trade. 

 

Privacy Policy 
To implement module functionality, certain device data are uploaded to Quectel’s or third-party’s servers, 

including carriers, chipset suppliers or customer-designated servers. Quectel, strictly abiding by the 

relevant laws and regulations, shall retain, use, disclose or otherwise process relevant data for the 

purpose of performing the service only or as permitted by applicable laws. Before data interaction with 

third parties, please be informed of their privacy and data security policy. 

 

Disclaimer  
a) We acknowledge no liability for any injury or damage arising from the reliance upon the information. 

b) We shall bear no liability resulting from any inaccuracies or omissions, or from the use of the 

information contained herein.  

c) While we have made every effort to ensure that the functions and features under development are 

free from errors, it is possible that they could contain errors, inaccuracies, and omissions. Unless 

otherwise provided by valid agreement, we make no warranties of any kind, either implied or express, 

and exclude all liability for any loss or damage suffered in connection with the use of features and 

functions under development, to the maximum extent permitted by law, regardless of whether such 

loss or damage may have been foreseeable. 

d) We are not responsible for the accessibility, safety, accuracy, availability, legality, or completeness of 

information, advertising, commercial offers, products, services, and materials on third-party websites 

and third-party resources. 

Copyright © Quectel Wireless Solutions Co., Ltd. 2024. All rights reserved. 
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1 Introduction 
 

QGNSS is a tool that allows you to interact with Quectel GNSS modules quickly and easily. It enables 

evaluation, performance testing, development and debugging of Quectel GNSS modules. Tool features 

are listed below: 

 

⚫ Supports receivers utilizing standard NMEA strings in compliance with NMEA 0183 V4.11 and 

previous versions. 

⚫ Supports the parsing of RTCM3.x protocol messages. 

⚫ Supports log replay. 

⚫ Presents all the information collected by the GNSS device. All aspects of GNSS data (positioning, 

velocity, time, satellite tracking, etc.) can be monitored and logged under various test scenarios for 

receiver evaluation. 

⚫ Supports the downloading of AGNSS data. 

⚫ Supports NTRIP Client, Server and Caster. 

⚫ Supports the downloading of firmware update packet to GNSS modules.



 
                                                    GNSS Module Series 

 

QGNSS_User_Guide                                                                  10 / 57 
 
 
 

2 User Interface Description 
 

2.1. Main Window 

 

The figure illustrated below is the initial window of QGNSS. 

 

Figure 1: Main Window 

 

2.2. Menu Bar 

2.2.1. File Tab 

In the “File” tab menu: 

 

⚫ Click “Open” to open the play dialog box. See Chapter 3.3 Log Play for details. 

⚫ Click “Show Logfile in Explorer” to open the folder of the saved log file. 

⚫ Click “Quit” to close QGNSS. 
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Figure 2: File Tab 

 

2.2.2. Device Tab 

In the “Device” tab menu: 

 

⚫ Click “Connect” to connect to the receiver. 

⚫ Click “Set Device Information” to configure serial port information. See Chapter 3.1 Connect to 

Receiver for details. 

 

Figure 3: Device Tab 

 

 

Make sure to configure the serial port information before connecting to the receiver. 

 

2.2.3. View Tab 

The main function of all sub-windows under “View” is to display key data. 

 

Figure 4: View Tab 

NOTE 
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2.2.3.1. Deviation Map Sub-Window 

The “Deviation Map” sub-window displays positions in longitude and latitude relative to the initial 

positioning point. 

  

Figure 5: Deviation Map 

 

 

1. Use the mouse scroll wheel to zoom in/out on the “Deviation Map” and hold down the left mouse 

button to drag the “Deviation Map”. Right click the mouse button to clear the points on the 

“Deviation Map”. 

2. The color of the points in the deviation map are determined by the different values of <Quality> 

field in the GGA message. 

 

Table 1: Deviation Map Function Description 

Icon Description 

N=504 Total points 

1:9(1.8%) GPS SPS Mode: 9 points in total (accounting for 1.8 % of the total points) 

2:1(0.2%) 
Differential GPS, SPS Mode or SBAS Mode: 1 point in total (accounting for 0.2 % of the 

total points) 

3:1(0.2%) GPS PPS Mode: 1 point in total (accounting for 0.2 % of the total points) 

NOTE 



 
                                                    GNSS Module Series 

 

QGNSS_User_Guide                                                                  13 / 57 
 
 
 

Icon Description 

4:300(59.5%) Fixed RTK Mode: 300 points in total (accounting for 59.5 % of the total points) 

5:192(38.1%) Float RTK Mode: 192 points in total (accounting for 38.1 % of the total points) 

6:1(0.2%) 
Estimated (dead reckoning) Mode: 1 point in total (accounting for 0.2 % of the total 

points) 

 

2.2.3.2. Online Map Sub-Window 

The “Online Map” displays real-time location reported by the module on a map. 

 

Figure 6: Online Map Sub-Window 

 

2.2.3.3. GNSS Signal View (Signal Level) Sub-Window  

The sub-window in the figure below (“Signal Level”) contains “Level View” and “Vertical View”.  

 

1. Level View Introduction 

 

“Level View” displays GNSS signal view. The number above the flag represents the C/N0 value. You can 

use the checkbox to select the satellite system to be displayed. If the flag is transparent, it means that the 

receiver is not tracking this satellite and therefore there is no data available in NMEA GSA messages. 
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Figure 7: Signal Level Sub-Window – Level View  

 

Click “...” to display the detailed information and click "Band" to hide the detailed information. 

 

Figure 8: Level View Detailed Information 

 

Table 2: Signal View Function Description 

Button Description 

Band Satellite frequency band. 

Code Sent by a satellite for ranging and satellite acquisition. 
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Button Description 

Band Satellite frequency band. 

Code Sent by a satellite for ranging and satellite acquisition. 

PRN Pseudo Random Noise Code. 

Azim Satellite azimuth in degrees. 

Elev Satellite elevation in degrees. 

 

2 Vertical View Introduction 

 

Click “Vertical View” to open the vertical satellite signal-to-noise ratio chart, which allows for a more 

intuitive comparison of the trends of satellite values among different constellations. 

 

Figure 9: Signal Level Sub-Window – Vertical View 

 

2.2.3.4. Sky View Sub-Window  

The “Sky View” sub-window displays the azimuth and elevation angle (above the Horizon) of each visible 

navigation satellite per constellation and counts the number of all visible satellites of each positioning 

system. 
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Figure 10: Sky View Sub-Window 

 

2.2.3.5. Data View Sub-Window 

The “Data View” sub-window displays the data information, such as longitude, latitude, altitude and fix 

mode. 

 

Figure 11: Data View Sub-Window 
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2.2.3.6. Configuration View Sub-Window  

The “Configuration View” sub-window is used to modify the receiver configuration. The configuration 

parameters may change depending on module type. “Query” button is used for querying commands in 

the current page. “Setting” button is used for generating commands and sending them to the GNSS 

module. 

 

Figure 12: Configuration View Sub-Window  

 

2.2.3.7. Dashboard View Sub-Window 

The “Dashboard View” sub-window is composed of four instrument panels, speed instrument panel, 

knots indicator, altitude instrument panel and heading instrument panel, which displays relevant data in 

the NMEA protocol. 

 

Figure 13: Dashboard View Sub-Window 
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2.2.3.8. IMU View Sub-Window 

The “IMU View” is composed of three curve charts, “IMU Output View”, “NotCalibrated1” and 

“NotCalibrated2”, for a more intuitive display of the real-time data fluctuations. The presentation of those 

three curves are the same, yet the data sources are different. The “IMU Output View” is derived from 

calibrated IMU data, and the data sources for “NotCalibrated1” and “NotCalibrated2” are IMU1 raw data 

and IMU2 raw data. By checking or unchecking the relevant checkbox, those curves can be displayed or 

hidden. 

Figure 14: IMU View Menu 

“IMU Output View” sub-window displays three-axis acceleration (ACC_X, ACC_Y, ACC_Z), three-axis 

angular rate (GYO_X, GYO_Y, GYO_Z), and Temperature, as well as the extreme and average values of 

these seven data in the form of curve charts. In addition, it also contains some user-friendly settings. 

Figure 15: IMU View Sub-Window 
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The details on “IMU Output View” are listed below: 

 

⚫ Data Point: Range of a single curve in the curve chart, which can be set to 100, 300, 500, 1000, 

2000 or 3000. 

⚫ Reset Zoom: Curve state restoration button. After clicking the button, the curve will be restored to its 

original state. 

⚫ Pause/Running Chart: Stop refreshing curve/refresh curve button. 

➢ After clicking “Pause Chart”, the button changes to “Running Chart”. At this time, the curve 

stops refreshing and interactive operations of the curve can be performed on the chart, such as 

viewing detailed data of a single point, moving and scaling the curve. 

➢ After clicking “Running Chart”, the button changes to “Pause Chart”. At this time, the curve is 

refreshing and the interactive operations of the curve is disabled. 

⚫ Minimum: Minimum value within the “Data Point” range. 

⚫ Average: Average value within the “Data Point” range. 

⚫ Maximum: Maximum value within the “Data Point” range. 

⚫ Stdev: Standard deviation within the “Data Point” range. 

 

Figure 16: IMU Curve Menu 

 

 

Figure 17: IMU Comparison 
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Right click the mouse to open the curve menu, the details are as follows: 

⚫ Clear: Clear all current data of the curve chart.

⚫ Refresh: The function is the same as “Reset Zoom”.

⚫ Comparison: Check to open the point comparison view to show data points on the Y-axis that

corresponds to the points on the X-axis. Parameters, taking data in the first row of Figure 17: IMU

Comparison as an example, are explained as follows:

➢ GYO_X: Curve name

➢ Unix: Unix time, Unit: Second

➢ UTC: UTC time

➢ V: Data points on the Y-axis that corresponds to the points on the X-axis

If the IMU time is not synchronized with the time of GNSS module, Unix time and UTC time will be 

converted according to the IMU time instead of the actual time. 

2.2.4. Setting Tab 

Click “preferences” in the dropdown menu of “Setting” to enter the “Preferences” sub-window and set 

the supported protocol to parse in the “Preferences” sub-window. 

Figure 18: Setting Tab Menu 

Figure 19: Preferences Sub-Window 

NOTE 
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2.2.5. Tools Tab 

The sub-windows in the “Tools” tab are illustrated below: 

 

Figure 20: Tools Tab Menu 

 

2.2.5.1. Switch Online Map 

You can switch between the online maps supported by the QGNSS (“TianDiMap” and “OpenStreetMap”) 

via “Switch Online Map” dropdown menu. 

 

Figure 21: Switch Online Map 

 

2.2.5.2. QConsole Sub-Window 

“QConsole” is a multi-functional sub-window that integrates “Console”, “Protocol Package” and 

“Message Statistics”. 
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Figure 22: QConsole Sub-Window 

 

1. Console Introduction 

 

The “Console” is a debugging window for the module’s original data. Right-click the mouse to popup the 

context menu. 

 

Figure 23: Console Context Menu 
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Figure 24: Details on Console Menu 

 

The “Console” context menu information is as follows: 

 

⚫ Show Tool: Set whether the left sidebar is visible. Shortcut: Ctrl+Q. 

⚫ Search: Regular match filtering and highlighting. Shortcut: Ctrl+F. 

⚫ Copy: Copy selected context. Shortcut: Ctrl+C. 

⚫ Select All: Select all current context in console. Shortcut: Ctrl+A. 

⚫ Clear: Clear current context. Shortcut: Ctrl+X. 

⚫ Pause: Control whether to pause data appending. Shortcut: Ctrl+P. 

⚫ Display: Control data display. 

➢ Auto Scroll: Control whether to enable automatic data scrolling. Shortcut: Ctrl+S. 

➢ Auto Warp: Control whether the data automatically wraps when it exceeds the window width. 

Shortcut: Ctrl+G. 

➢ Show Time: Control whether to display the timestamp Shortcut: Ctrl+T. 

➢ Show RX: Control whether to display the received data. Shortcut: Ctrl+R. 

➢ Show TX: Control whether to display the sent data. Shortcut: Ctrl+O. 

➢ Plain mode: Control whether to output raw data without adding any extra characters. Shortcut: 

Ctrl+L. 

➢ Show Script: Control whether to display the script sending window. Shortcut: Ctrl+Shift+S. 

⚫ Format: Text encoding. 

➢ Bin: Binary encoding. 

➢ Hex: Hex encoding. 

➢ Ascii: ASCII encoding. 

 

Table 3: Description of Console Functions 

Icon Function Description 

 Search Regular match filtering and highlighting 
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Icon Function Description 

 Clear Clear current context 

 Pause Control whether to pause data appending 

 Auto scroll Control whether to enable automatic data scrolling 

 Auto warp 
Control whether the data automatically wraps when it exceeds the 

window width 

 Show time Control whether to display the timestamp 

 Show RX Control whether to display the received data 

 Show TX Control whether to display the transmitted data 

 Plain mode Control whether to output raw data without adding any extra characters 

 Show Script Control whether to display the script sending window 

 Send Data Click to send input data 

 Advance Configure the data parameters to be sent 

 Match Case Control whether to enable case matching 

 Enable Filtering Control whether to enable filtering 

 

Press the shortcut key “Ctrl+F” or click the  button to display the search box in the upper right corner. 

Enter the relevant content and click the  button under the search box to display the matched data in 

the new right box. 

 

Figure 25: Console Data Filtering 
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Click the  button in the left column of “Console”, the “Script Send” window pops up. You can send 

one command at a time or enabled commands cyclically through this window, see Chapter 3.2.2 Script 

Send for details. Besides, the window also supports importing and exporting scripts. 

 

Figure 26: Script Console 

 

Introduction on pop-up menu associated with the “Advance” button: 

 

⚫ Description: Input data description. Add this information to mark the purpose of the input data, which 

is useful when you open a previous script. 

⚫ Delay: Regulate the delay in milliseconds before the data is transmitted. 

⚫ Text format: Format of sent data, classified as: 

➢ Bin: Send binary data. 

➢ Hex: Send hexadecimal data. 

➢ Ascii: Send ASCII data. 

⚫ Checksum Type: Checksum types, classified as: 

➢ NONE: No checksum by default. 

➢ NMEA: Add NMEA checksum. 

➢ RTCM3: Add RTCM3 checksum. 

⚫ Suffix: Suffix information, classified as: 

➢ None: No suffix. 

➢ CR: Carriage return. Add suffix ‘\r’. 

➢ LF: Line feed. Add suffix ‘\n’. 

➢ CRLF: Carriage return line feed. Add suffix “\r\n”. 

➢ LFCR: Line feed carriage return. Add suffix “\n\r”. 

 

2. Protocol Package Introduction 

 

“Protocol Package” displays the parsed message. When the specific message on the left is selected, 

manually click on the right sidebar to support display of detailed message information. 
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Figure 27: Protocol Package 

 

Right-click the mouse and context menu pops up. 

 

⚫ Search: Regular match filtering. Shortcut: “Ctrl+F”. 

⚫ Clear: Clear current context. Shortcut: “Ctrl+X”. 

⚫ Auto Scroll: Control whether to enable automatic data scrolling. Shortcut: “Ctrl+S”. 

⚫ Column Visible: Control which columns are visible. 

➢ Index: Message index. 

➢ Time: Receiving time. 

➢ Protocol: Protocol type. 

➢ Type: Message type. 

➢ ASCII: ASCII encoding display. 

➢ HEX: Hexadecimal encoding display. 

➢ Size: Number of bytes. 

➢ Remark: Remark reserved for future use. 

 

3. Message Statistics Introduction 

 

“Message Statistics” perform statistics on parsed messages and record the received interval. 

 

Figure 28: Message Statistics 
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2.2.5.3. Firmware Download Sub-Window 

The “Firmware download” sub-window is used to upgrade the module firmware. See Chapter 3.8 

Firmware Download for the general process of firmware upgrade. If the detailed process of firmware 

upgrade via QGNSS for a specified module is required, please refer to the corresponding firmware 

upgrade guide. 

 

Figure 29: Firmware Download Sub-Window 

 

2.2.5.4. Coordinate Converter Sub-Window 

1. In the “Coordinate Converter” Sub-Window: 

 

⚫ Select one of the “LLA(Deg)”, “LLA(Deg,Min)”, “LLA(Deg,Min,Sec)”, or “ECEF(XYZ)” coordinate 

system formats, taking “LLA(Deg)” as an example: 
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Figure 30: Coordinate Converter Sub-Window – Enter Values 

 

⚫ Click “Convert” and the tool will convert the values to other formats. 
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Figure 31: Coordinate Converter Sub-Window– Convert Values 

 

2. In the “Finding Coordinate Distance” Sub-Window: 

 

⚫ Enter the latitude and longitude of starting and end points to calculate the straight-line distance 

between two points. 
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Figure 32: Finding Coordinate Distance Sub-Window 

 

2.2.5.5. QGNSSLog Sub-Window 

The “QGNSSLog” displays a line chart of satellite signal-to-noise ratio, number of visible satellites, and 

number of satellites in use, and presents satellite data in the NMEA message. 

 

Figure 33: QGNSSLog Sub-Window 
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There are “Plots” and “Signals” options on the right side of “QGNSSLog”: 

 

⚫ “Plots” displays the current time, options of the three curve charts, i.e., satellite signal-to-noise ratio, 

number of visible satellites, and number of satellites in use, and the extremum and average values of 

the signal bands. 

⚫ “Plots” displays or hides the curves. 

 

Figure 34: QGNSSLog Right Tab 

 

Right-click to open the curve menu. 

 

⚫ Clear: clear all current data related to curve charts. Shortcut: Ctrl+Del 

⚫ Refresh: Restore curve charts to their initial state. Shortcut: F5 

⚫ Comparison: Check to open the point comparison view to show data points on the Y-axis that 

correspond to the points on the X-axis. 
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Figure 35: Curve Menu 

 

 

Figure 36: QGNSSLog Comparison 

 

There will be an additional curve chart in “QGNSSLog” in the playback state, showing the CEP values of 

L1, L2, L5 and L6. 
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Figure 37: QGNSSLog CEP 

 

2.2.5.6. NMEA Convert KML Sub-Window 

The “NMEA Convert KML” sub-window is used for converting NMEA logs to a KML format file. 

 

⚫ Click “File Name(s)” to select the input NMEA file. 

⚫ Click “File Name” to select the output file location. 

⚫ Click “OK” to wait for the conversion to complete. 

  

Figure 38: NMEA Convert KML Sub-Window  
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2.2.5.7. NTRIP Sub-Window 

See Chapter 3.7 Build NTRIP System for details. 

 

2.2.5.8. AGNSS Sub-Window 

Via the “AGNSS”, you can download AGNSS files from the FTP server and AGNSS data to the receiver 

through the serial port. See Chapter 3.6 Send AGNSS Data for details. 

 

Figure 39: AGNSS Sub-Window 

 

2.2.6. Windows Tab 

In the “Windows” tab menu: 

 

⚫ Click “Tile pattern” to display the sub-window(s) in a tile pattern. 

⚫ Click “Cascade” to display the sub-window(s) in a cascade pattern. 

⚫ Click “Close All” to close all sub-windows. 
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Figure 40: Window Tab Menu 

 

Display all the sub-windows in a tile pattern. 

 

Figure 41: Tile Pattern Window 

 

Display all the sub-windows in a cascade pattern. 

 

Figure 42: Cascade Window 
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Closes all windows. 

 

Figure 43: Close All Window 

 

2.2.7. Help Tab 

 

Figure 44: Help Tab Menu 

 

2.2.7.1. About 

Display QGNSS version and compile time. 

 

Figure 45: About Sub-Window 
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2.2.7.2. License Management Sub-Window 

1. Generate registration code: Enter the username and email address and click the "Generate 

Registration Code" button to generate the registration code. 

2. Import license management and control function: Click “Select License” to obtain a license. 

 

Figure 46: License Management 

 

2.3. Tool Bar 

 

Tool bar can be used for quick access to common operations. 

 

Figure 47: Tool Bar 

 

Table 4: Description of Tool Bar Functions 

Icon Function Description 

 Connect Connect/disconnect serial port 

 Set Device Information Select module and set serial parameter(s) 

 Open Play log file 

 Show Logfile in Explorer Open the folder containing the saved log file(s) 
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Icon Function Description 

 Cold Start Send a Cold start command 

 Hot Start Send a Hot start command 

 Warm Start Send a Warm start command 

 Full Cold Start Send a Full cold start command 

 GNSS Signal View Open the “Signal Level” sub-window 

 Online Map Open the “Online Map” sub-window 

 Sky View Open the “Sky View” sub-window 

 Deviation Map Open the “Deviation map” sub-window 

 
NTRIP Client Open the “NTRIP Client” sub-window 

 
NTRIP Caster Open the “NTRIP Caster” sub-window 

 
NTRIP Server Open the “NTRIP Server” sub-window 

 
Stop Play Stop log play 

 
Start Play Start log play 

 
Play Speed Select different rates for log play 

 
Play Pause Click to pause log play 

 Play progress slider bar 
Play progress bar, and click to drag the progress 

bar 
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3 Common Operations 
 

3.1. Connect to Receiver 

 

Follow the below steps to connect the receiver to the QGNSS software utility: 

 

Step 1 Run the QGNSS tool. 

Step 2 Click the “Set Device Information” button on the tool bar to open the “Device Information” 

window. 

 

Figure 48: Open Serial Port Configuration 

 

Step 3 Select the module and serial port parameters, and then click the “OK” button. 

  

Figure 49: Serial Port Configuration Dialog 
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3.2. QConsole 

3.2.1. Data Matching 

Pressing the “Ctrl+F” shortcut key in “Console” and “Protocol Package” will hide or show the search 

widget. 

 

Figure 50: Search Widget 

 

For example, input “RMC” and then the matched strings will be highlighted. Then click  button, the 

right side of “Console” sub-window will display the matched newline data. 

 

Figure 51: Console Data Matching 

 

The tool also supports regular matching. For instance, 

using“\$[A-Z]{2}(RMC|GGA)[,]{1}[,.A-Za-z0-9]{1,}\*”to match the RMC or GGA messages. 
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Figure 52: Console Data Regular Matching 

 

 

Figure 53: Protocol Package Regular Matching 
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3.2.2. Script Send 

Click the  button on the left column of “Console” to pop up the “Script Send” window 

 

Figure 54: Send Script 

 

Send one command at a time: 

1. Enter the command to be sent in the command box. 

2. Click the “Advance” button to configure the sending parameters in the pop-up menu. 

3. Click  to send the command.  

 

Send enabled commands cyclically: 

1. Enter the commands to be sent in the command boxes one by one.  

2. Click the “Advance” button to configure the sending parameters in the pop-up menu, as shown in 

Figure 26: Script Console. 

3. Enter the number of cycles in the box after “Times” and the delay time (unit: ms) of each cycle in the 

box after “Delay”. 

4. Click  button, as showin in Figure 26: Script Console, to send the commands cyclically. If you 

want to end the command sending in advance click . 
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3.3. Log Play 

 

Steps to replay a recorded log file: 

 

Step 1 Click the “Play” button to open the play dialog box. 

  

Figure 55: Log Play 

 

Step 2 Select the module and enter log file path and then click the “OK” button. 

   

Figure 56: Select the File 

 

Step 3 Select the Read Rate (B/s) value. 

 

Figure 57: Play Controller 

 

See Table 4: Description of Tool Bar Functions for the descriptions of above buttons. 
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3.4. Restart Receiver 

 

Choose a restart type and click the corresponding button in the tool bar to send the restart command to 

the receiver. For the description of these buttons, see Table 4: Description of Tool Bar Functions.  

 

Figure 58: Restart Receiver 

 

3.5. Configure Receiver 

 

Click “Configuration View” in the “View” tab drop-down menu to open “Configuration View” window. 

  

Figure 59: Open Configuration View 

 

Step 1 Select the parameters to be configured and click “Setting” button. 

Step 2 If the parameters support the query, click the “Query” button to query the configuration 

parameters. 
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Figure 60: Configuration View 

 

3.6. Send AGNSS Data 

 

Click “AGNSS” in the “Tools” tab drop-down menu to open “AGNSS” window. 

 

Figure 61: Open AGNSS Window 
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Step 1 Get AGNSS file: 

1. Click “Connect” to connect to the FTP server. 

2. Select the AGNSS file to be downloaded and click “Download selected file”. 

 

Figure 62: AGNSS Sub-Window 

 

 

Figure 63: Connect to FTP Server 
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AGNSS file is used to improve the TTFF duration by providing long duration Ephemeris to the receiver. 

 

Step 2 Send AGNSS data to the receiver: 

1. Enter the file path (file local path). 

2. Click “Download” and wait for the data transmission to complete. 

 

Figure 64: Send AGNSS Data 

 

3.7. Build NTRIP System 

 

“Networked Transport of RTCM via Internet Protocol” (NTRIP) stands for an application level protocol 

streaming "Global Navigation Satellite System (GNSS)" data over the Internet. This section will overlook 

the NTRIP system supported by the QGNSS. Currently the QGNSS supports “NTRIP Caster”, “NTRIP 

Server” and “NTRIP Client” functions. For more detailed information on NTRIP, see document [1] RTK 

application note. 

 

3.7.1. NTRIP Caster 

The QGNSS tool has implemented the “NTRIP Caster” function, which can deploy “NTRIP Caster” 

through the QGNSS tool to receive and send GNSS data streams. The detailed steps are as follows: 

Step 1 Open the QGNSS tool, click the “NTRIP” option in the dropdown menu of “Tools”. Then click the 

“NTRIP Caster” option, as shown in the figure below. 

NOTE 
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Figure 65: Open NTRIP Caster 

 

Step 2 Enter the Address, Port, User, and Password of “NTRIP Caster”. If the Internet is required, make 

sure that the IP and ports can access to the Internet. 

Step 3 Check the checkbox next to the “Start/Stop” and start the “NTRIP Caster”, as shown below. 

 

Figure 66: Start NTRIP Caster 
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Quectel provides temporary “NTRIP Caster” to facilitate testing, the detailed information are listed 

below: 

Address: 172.29.104.32 

Port: 7990  

User: QL_NTRIP 

Password: 123456 

 

3.7.2. NTRIP Server 

Quectel not only has GNSS high-precision positioning modules, but also GNSS modules with original 

observation data, such as LC29H (BS) and LG69T (AS). This section introduces how to build “NTRIP 

Server” via the QGNSS using LC29H (BS) as the base station. 

Step 1 Open the QGNSS tool and connect the LC29H (BS) module. 

Step 2 Set the LC29H (BS) module as a Fixed mode or Survey-in mode.  

1. If you know the true coordinate where the base station mounted, you can set the LC29H (BS) 

to Fixed mode and send the coordinate in ECEF format. For example: 

Host Send: $PQTMCFGSVIN,W,2,0,0.0,-2472446.4619,4828304.1363,3343730.2653*34 

Module Response: $PQTMCFGSVIN,OK*70 

 

If you don’t know the true coordinate, you can set the LC29H (BS) to Survey-in mode which 

determines the receiver’s position by building a weighted mean of all valid 3D positioning 

solutions. For example: 

Host Send: $PQTMCFGSVIN,W,1,43200,15.0,0.0,0.0,0.0*13 

Module Response: $PQTMCFGSVIN,OK*70 

 

2. Save the parameters: 

Host Send: $PQTMSAVEPAR*5A 

Module Response: $PQTMSAVEPAR,OK*72 

Step 3 Click the “NTRIP” in the dropdown menu of “Tools”. Then click “NTRIP Server”, as shown below. 

NOTE 
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Figure 67: Open NTRIP Server 

 

Step 4 Enter Caster Address, Port, User, Password and Mountpoint. Ensure Caster Address, Port, User 

and Password are correspond to the “NTRIP Caster” to be connected. Mountpoint is the mount 

point to distinguish different NTRIP Source, and the input value is determined by the user. 

“NTRIP Client” obtains the correction data through the corresponding mountpoint. 

Step 5 Check the checkbox next to the “Start/Stop” and start “NTRIP Server”, as shown in the figure 

below. After the  “NTRIP Server” function is started, the original observation data of LC29H (BS) 

will be transmitted to “NTRIP Caster”. 

 

Figure 68: Start NTRIP Server 
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In the Step 2, you can set a lower number of positioning in Survey-in mode, such as 300, facilitating a 

rapid examination of the RTK outcomes. Nonetheless, for the acquisition of an accurate base 

coordinate, it is advised to extend the number of positioning to a minimum of 43200. 

 

3.7.3. NTRIP Client 

The NTRIP is a gateway for GNSS modules to receive RTK corrections, which can effectively improve the 

positioning accuracy. Click “NTRIP Client” in the “Tools” tab drop-down menu to open “NTRIP Client” 

window. 

 

Figure 69: Open NTRIP Client 

 

3.7.3.1. NTRIP Client 

Use an NTRIP (V1.0) Client to connect to a standard “NTRIP Caster”, and follow these steps: 

 

Step 1 Enter the Address, Port, User and Password as shown in Figure 71: NTRIP Client. Contact 

Quectel Technical Support to get the username and password if necessary. 

Step 2 Click “Update NTRIP source table” and wait for the server to return mount point information. 

Step 3 Select “NTRIP mount point”. 

Step 4 Enter “Request Interval”. 

Step 5 Tick the checkbox next to “Use manual position” and a window as shown in figure below pops 

up for entering the relevant position data. If the checkbox of “Use manual position” is unticked, 

the module will use the data of <Quality> parameter of the GGA message in Fixed mode. 

NOTE 
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Figure 70: Set Manual Position 

 

Step 6 Turn on the “Connect to Host” switch. 

 

Figure 71: NTRIP Client 

 

Step 7 Check whether the GNSS module receives the differential correction data. After receiving the 

differential correction data, check whether the value of parameter <Quality> in the GGA 

messages is 4 (4 corresponds to the fixed RTK mode), as shown in Figure 72: The Module 

Enters the Fixed RTK Mode. 
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Figure 72: The Module Enters the Fixed RTK Mode 

 

3.7.3.2. Data Monitor 

Click “Monitor” to open the Data Monitor dialog box where you can view the differential correction data 

sent by the server. 

 

Figure 73: RTK Data Monitor 
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3.8. Firmware Download 

 

Connect to the receiver as explained in Chapter 3.1 Connect to Receiver. Click “Firmware Download” in 

the “Tools” tab drop-down menu to open “Firmware Download” window. 

  

Figure 74: Open Firmware Download 

 

Step 1 Click  to select the receiver firmware. 

Step 2 Click to select download baudrate. 

Step 3 Click  to start the firmware download process and wait for the process to complete. 

Step 4 Reset module. 
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Figure 75: Firmware Download Process 

 

 

 

The steps for downloading the firmware via QGNSS tool may vary from module to module. See 

firmware upgrade guide of specific module for details. 

 

NOTE 
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4 Appendix References 
 

Table 5: Related Document 

 

Table 6: Terms and Abbreviations 

Abbreviation Description 

AGNSS Assisted GNSS 

BDS BDS Navigation Satellite System 

C/N0 Carrier-to-Noise-Density Ratio 

CEP Circular Error Probable 

DR Dead Reckoning 

EPH Ellipsoid Height 

Galileo Galileo Satellite Navigation System (EU) 

GLONASS Global Navigation Satellite System 

GPS Global Positioning System 

IRNSS Indian Regional Navigation Satellite System (NavIC) 

KML Keyhole Markup Language 

MSL Mean Sea Level 

NTRIP Networked Transport of RTCM via Internet Protocol 

PRN  Pseudo Random Noise Code 

QZSS Quasi-Zenith Satellite System 

Document Name 

[1] Quectel_GNSS_RTK_Application_Note 

http://www.baidu.com/link?url=wInhalgzbOb9o0OxmAp6KRrmka8iJGrxjHgY7RaOMuS
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Abbreviation Description 

RTK Real-time Kinematic 

SBAS Satellite-Based Augmentation System 

TTFF Time to First Fix 
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